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Disclaimer 
 
 

The contents of this report reflect the views of the authors who are responsible for the 
facts and the accuracy of the data presented herein.  The contents do not necessarily 
reflect the official views or policies of the Ohio Department of Transportation or the 
Federal Highway Administration. This report does not constitute a standard, 
specification or regulation. 
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1. INTRODUCTION 
 
Obtaining sensor orientation by direct measurements is a rapidly emerging mapping 
technology. Modern GPS and INS systems allow for the direct determination of 
platform position and orientation at an unprecedented accuracy. In airborne surveying, 
aircraft trajectory and platform orientation can be determined at the level of few cm 
and 20-30 arcsec, respectively at an almost continuous time scale. The use of such 
integrated GPS/INS systems offers immediate benefits for large-format camera-based 
airborne surveying by substantially reducing the need for ground control and by 
basically eliminating aerial-triangulation, except for system calibration. For emerging 
sensors such as LIDAR, RADAR, multi-/hyperspectral imagers, however, the use of 
the direct orientation systems is mandatory since indirect methods such as control 
point-based aerial-triangulation are not feasible. ODOT Aerial Engineering has been 
operating an airplane with a large-format Zeiss Jena LMK2000 camera. The 
introduction of a modern GPS/INS-based direct orientation system was not only 
highly desirable for economic reasons, but also mandatory if ODOT wanted to keep 
up with technological developments. Since ODOT predominantly performs corridor 
surveys over the highway infrastructure, the use of direct orientation makes it even 
more attractive in this case, since the savings due to the elimination of control points 
are quite substantial. By establishing a GPS/INS-based direct orientation technology 
for ODOT aerial operations, the foundations was given for future imaging sensor 
extensions such as the introduction of LIDAR systems or the like. 
 
 
2. RESEARCH OBJECTIVES 
 
The primary objectives of this research project were as follows: 
 

•  To augment the existing airplane sensor configurations with a commercially 
available GPS/INS system (Applanix POS/AV), 

•  To carry out test flights to benchmark the performance of the POS system 
against AIMS GPS/INS, 

•  To perform the extended quality assurance analysis based on the above 
mentioned airborne test with multiple sensors, 

•  To consult ODOT personnel in GPS/INS technology/data acquisition and 
processing, 

•  To consult ODOT personnel on future developments such as the introduction 
of high-resolution digital cameras (CCD), LIDAR systems, etc.  

 
 
3. GENERAL DESCRIPTION OF RESEARCH 
 
Sensor orientation, also called image georeferencing, is defined by a transformation 
between the image coordinates specified in the camera frame and the selected 
mapping reference frame. This process requires knowledge of the camera interior and 
exterior orientation parameters. The interior orientation (IO), i.e., principal point 
coordinates, focal length and lens geometric distortion characteristics are only 
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concerned with the modeling of the camera projection system, and are provided by the 
camera calibration procedure (traditionally, analog cameras are laboratory-calibrated, 
while digital cameras are calibrated using well-defined indoor or outdoor calibration 
ranges). On the other hand, the exterior orientation parameters (EOP) directly define 
the position and orientation of the camera at the moment of exposure. In traditional 
airborne surveying, the exterior orientation parameters are obtained by aerial 
triangulation (AT) based on the object space information (ground control points) and 
their corresponding image coordinates. As a result of using a mathematical model 
(collinearity equations) representing the transformation between the object and image 
spaces, the EOP are determined, providing a relationship between the image 
coordinates and the global (or local) mapping reference frame. The combined bundle 
adjustment usually facilitates not only EOP determination, but may also involve 
rectification of the camera IO (pre-determined by laboratory calibration procedure). 
Unfortunately, the significant part of the AT cost is associated with the establishment 
of ground control points, which might be prohibitive in cases of mapping of remote 
areas. Consequently, the direct orientation provided by GPS/INS (i.e., direct EOP or 
DOP, without a process of AT), is highly advantageous, provided that the satisfactory 
accuracy level is achieved, as it virtually eliminates most of ground control, and 
problems of image matching and need of approximate tie points required for 
automatic AT to recover exterior orientation. However, a crucial point of application 
of direct georeferencing is the accuracy and reliability of DPO, depending primarily 
on sensor quality, stability and accuracy of the system calibration, quality of time 
synchronization, and the type of the data processing algorithm.  
 
DPO, as explained earlier, can be accomplished by inertial navigation or a multi-
antenna GPS, or, for the highest accuracy, by integration of both systems to utilize 
their complementary features. Thus, based on discrete measurements, georeferencing 
determines the time dependent vector )(, tr INSM  and matrix )(tR M

BINS  (see equation 2), 
hence the problem is equivalent to finding six parameters of rigid body motion, under 
the assumption that the sensor is a rigid body. Since we are dealing with discrete 
observations, some modeling and estimation are introduced to relate measurements to 
the unknown filter states, and interpolation is needed to relate the estimated trajectory 
to the epochs of image exposure. In principle, no external information such as ground 
control is needed, except for the GPS base station and the boresight calibration range, 
which is usually needed prior to the mapping mission.  Since the DPO rotational 
components are naturally related to the INS body frame, in order to relate the 
GPS/INS-derived positions, INS-derived attitude components and image point 
coordinates, a multi-sensor system calibration is required. This procedure must be 
able to resolve (with a sufficient accuracy) the misalignments between the INS body 
frame and the imaging sensor frame (boresight transformation), and GPS/INS lever 
arm. The boresight components are usually determined on a specialized test range, 
while the linear offsets between the GPS antenna phase center and the center of the 
INS body frame are precisely measured using traditional surveying techniques. In 
addition, an imaging sensor must be calibrated to determine the camera interior 
orientation. The concept of georeferencing is illustrated in Figure 1 and described in a 
form of the coordinate transformation in equation 2, while the operational architecture 
of DPO determination with GPS/INS is presented in Figure 2. 
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Figure 1. Direct georeferencing: the concept. 
 
The mapping frame (m-frame) introduced in Figure 1 and equation 2 can be any 3D 
geodetic reference frame, such as WGS84, NAD83 or UTM (plus the height 
information) or any other selected Earth-fixed reference system. The body frame (b-
frame) is defined as the INS sensor frame, attached to the IMU chassis. If the sensors 
are rigidly mounted in the vehicle (say aircraft), the changes of b-frame with respect 
to m-frame follow the motion of the aircraft. For the m-frame selected as a local level 
frame, East-North-Up (ENU), the three rotations by heading, pitch and roll angles, 
defined as ωφκR , provide transformation from b to m-frame (equivalent to )(tR M

BINS  in 
equation 2, where time argument indicates that this matrix varies with the motion of 
the platform).  If the m-frame is selected as a 3D Earth-centered-fixed Cartesian frame 
(ECEF), the matrix )(tR M

BINS  becomes a product of ωφκR  (provided by INS) and 
ECEF
ENUR  (see equation 1); the subscript t indicates the time-dependence as a function of 

the platform coordinates, latitude ϕ and longitude λ.  
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Figure 2. Operational architecture of DPO determination with GPS/INS. 

In order to meet the project goals listed in Section 2, a commercially available 
integrated GPS/INS system, POS/AV 510, was acquired from Applanix Corp. The 
operational specs of the POS/AV 510 system are listed below, and the performance 
characteristic, achieved during the test flights is discussed in details in Appendix B. 
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Specifications subject to change without notice
04 06 2003

POS AV 510 V5 Specifications:
33BM61 IMU

1. Performance

POS AV 510 V5 Absolute Accuracy Specifications (RMS)

C/A GPS DGPS
RTK Post-

Processed

Position (m) 4.0 – 6.0 0.5 - 2 0.1 – 0.3 0.05 - 0.3

Velocity (m/s) 0.05 0.05 0.01 0.005

Roll & Pitch (deg) 0.008 0.008 0.008 0.005

True Heading 1 (deg) 0.070 0.05 0.04 0.008
1 Typical mission profile, max RMS error

POS AV V5 510 Relative Accuracy Specifications

Noise (deg/sqrt(hr)) < 0.01

Drift (deg/hr) 1 0.1
1 Attitude will drift at this rate up to a maximum error defined by absolute 
accuracy in table above.

2. Physical

Temp. Range: IMU -20 deg C to +55 deg C
PCS -20 deg C to +60 deg C

Size: IMU 150 mm L x 120 mm W x 100 mm H
(5.9 in L x 4.7 in W x 3.9 in H)

PCS 279 mm L x 165 mm W x 91 mm H
(11.0 in L x 6.5 in W x 3.6 in H)

Weight: IMU 2 kg
PCS 2.90 kg

Power: 20 -32 Volts DC
IMU 45 W, Max (supplied by PCS)
PCS 30 W, Max

3. General - Sensors

IMU

• 250 Hz High performance DTG gyros, accelerometers

GPS

• 12 channel dual frequency (L1/L2), low noise, DGPS ready, 
10 Hz raw data

4. Ethernet Input/Output (100 base -T)

Parameters Time tag, status, position, attitude, velocity, 
track and speed, dynamics, performance 
metrics, sensor data

Display Port Low rate (1 Hz) UDP protocol output
Control Port TCP/IP input for system commands
Primary port Real-time high rate (up to 250 Hz) TCP/IP

protocol output

5. Logging Output to Internal 1 Gbyte Flash Disk Drive

and/or Ethernet (Buffered TCP/IP)

Parameters Time tag, status, position, attitude, velocity, 
track and speed, dynamics, performance 
metrics, raw IMU data (200 Hz), raw GPS data 
(10Hz)

6. RS232 NMEA Output 

Parameters NMEA Standard ASCII messages
Position ($INGGA), Heading ($INHDT), Track
and Speed ($INVTG), Statistics ($INGST)

Rate Up to 50 Hz (user selectable)
Baud 4800 to 115200 (user selectable)
Protocol User selectable 

7. RS232 High Rate Binary Output

Parameters Time tag, roll, pitch, true heading, latitude, 
longitude, altitude
Time of Validity pulse (250 Hz)

Rate Up to 250 Hz (user selectable)
Baud 19200 to 115200 (user selectable)
Protocol User selectable

8. RS232 Input Interface s

Parameter Gimbal encoder input,
AUX GPS Input (RTK, NavCom Starfire),
RTCM104 DGPS Corrections Input

Rate 1 to 200 Hz
Baud 9600 to 115200 (user selectable)
Protocol User selectable

9. Other I/O

1PPS 1 pulse-per-second Time Sync output, 
normally high, active low pulse

Event Input Two input discretes used to mark external 
events.  Discretes are TTL pulses > 1 msec 
width where rising or falling edge is time-
tagged and logged (Max rate 100 Hz).

10. User Supplied Equipment

10.1 PC for POS Controller (Required for configuration)

• Pentium 90 processor (minimum)
• 16 MB RAM, 1 MB free disk space
• Ethernet adapter (RJ54 10 0 base T)
• Windows

10.2 PC for POSPac Post-processing Software

• Pentium 90 processor (minimum)
• 16 MB RAM, 1 MB free disk space
• Windows
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4. RESULTS 
 
The extensive system calibration and performance validation were carried out based on two 
test flights performed by Aerial Engineering Office. The data were processed and analyzed at 
OSU, and the detailed description of the results is provided in Appendix B. In particular, lever 
arm calibration, boresight calibration and navigation module quality check were performed, 
as detailed in Appendix A. Multiple CORS reference stations were used in the solution. 
Detailed analyses of the quality  of the GPS and GPS/INS solutions were performed. The 
following data sets were used: 
 

•  Installation test flight 
•  Toledo dataset, Dec. 03 2002 
•  Franklin 670 dataset , Dec. 6 2002 
•  Defiance mapping dataset, Dec. 9 2002 
•  Defiance airport dataset, Dec. 10 2002   

 
The boresight offsets and angles between the INS and the camera should be very stable, due 
to unique installation of the IMU in the camera cone. The offsets were surveyed very 
precisely by the OAE personnel, and the boresight angles were calibrated and are fixed in the 
Applanix data processing suite. The lever arm offsets between GPS and IMU should be 
dynamically calibrated during the GPS/IMU data processing. 
 
 
5. CONCLUSIONS 
 
Since the only way to test the performance is thorough independent georeferencing method, 
such as aerotriangulation (AT) based on control points, which for practical reasons is not 
performed, except for the system calibration, the following test procedures are suggested: (1) 
closely monitor the QA/QC (quality assurance/quality control) parameters during the 
navigation solution, as detailed below; and (2) run an automated AT (with no control) seeded 
by the GPS/INS solution that provides the image orientation refinement. Based on the 
extensive testing and system calibration, the following can be concluded in terms of 
operational practice in GPS/INS data processing to assure the best solution quality: 
 
a. GPS Data processing 
 

•  Forward/backward data processing is recommended 
•  L2 should be used for ambiguity resolution, if possible 
•  L2 should be used for ionospheric modeling, if possible 
•  Criteria to control the quality of a GPS solution 

o “forward/backward separation”: normally for 20-30km baselines, the 
separation should be 20-30cm. 

o “Ambiguity Fixed Information”: Normally fixed solution is better than a 
float solution; however, if a substantial difference is found in the 
“forward/backward separation”, wrong integer ambiguity could exist in 
the forward or backward fixed solution. 

o “Combined RMS”: select the solution with smallest RMS when multiple 
solutions are performed. 

o  “Position Standard Deviation”: select the solution with a minimum 
value. 
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•  Ionospheric free model and relative ionospheric model should be peformed and 
compared; normally ionospheric free model will generate better solution. 

•  Different base stations with selected segments and different processing 
directions should be considered to select the best solution. 

•  “Standard Deviation” and “Rejection tolerance” for Code and Phase should be 
properly selected by checking residuals of the float solution. 

•  Different ionospheric noise models (mainly depending on the quality of L2 data) 
should be tested to get an optimal solution; normally, the “auto noise model” 
will work well. 

•  Test different KAR options, such as KAR time and search region size; if solution 
can not be found, default settings will work. 

 
b. IIN Kalman Filter data processing 
 

•  Criteria to control the quality of the IIN Kalman Filter 
o Measurement Residuals should be noise-like. 
o Estimated Sensor Errors should reflect the quality of IMU hardware. 

•  “Adaptive RMS” for “Position measurement” should be used 
•   “Fixed RMS” for “Velocity measurement” should be used 
•  If IIN Kalman Filter fails, the “processing log” should be checked Normally the 

problem is caused by “too many consecutive measurement rejections”.  
o Increase the “Number of consecutive measurement rejections” (50). 
o Increase the “Measurement Residual Ratio” from 3 to 5 or 6, but not too 

much, since it may decrease the reliability of the final solution. 
o Increase the “Scale factor” (1.0) in the “Adaptive RMS”, but it may risk the 

reliability of the final solution 
o Do not use the “Velocity measurement”, if too many rejections come from 

velocity. 
o Relax the quality of the GPS solution from ID to FD, CD, or even C/A. Also 

it will degrade the accuracy of the final solution, but at least some solution 
can be generated. 

•  Lever arm offsets should be properly calibrated either before the flights or re-
calibrated in the data reduction procedure. 

 
Based on the test flights analyzed in Appendix B it can be concluded that the Applanix 
system meets the performance specifications, as described by the manufacturer. Especially the 
recent update of the GPS/INS processing engine provides more robust georeferencing 
solution, and supports better user interface.  
 
 
6. IMPLEMENTATION PLAN 
 
The OSU staff worked in close collaboration with ODOT OAE personnel to assure 
that all functional aspects of the system’s operation are followed during the field 
procedure. This included test flights, calibration and training seminars for the OAE 
staff.  
 
The system is fully implemented and installed in the OAE airplane, and has been 
operational since fall 2002. To support daily operations and effective data processing 
and analysis, the “GPS/INS data processing strategies with POSPac Software” are 
included in Appendix A. 
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APPENDIX A 
 

GPS/INS data processing strategies with POSPac Software 
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1. Software overview 
 
1.a. Objective of Appanix POS computing products 
 
! Correlate sensory data derived from various sources such as GPS, gyros, accelerometers 

and other devices. 
! Provide accurate navigation solution in real-time and post-processing. 
! Extract and process raw data. (Post-processing) 
! Identify and compensate for sensor and environmental errors. (Post-processing) 
! Compute an optimally accurate, blended navigation solution. (Post-processing) 
 
Workflow for data Post-processing 

Raw Pos
 Data

Extract Data

PosGPS
Base Station Data

mgps_kernel.nov

PosProc

gps_pri_kernel.dat

imu_kernel.dat
PosEO

PhotoID File (opt)

event1_kernel.dat

sbet_kernel.out EO data

Figure 1A: Workflow for data post-processing 
 
1.b. Data extraction 

 
Objective: 
! Extract stored raw GPS and IUM data, and detect potential data problems, such as 

gaps 
 

 
Figure 2A: Extract POS Data 
 
Steps: 
! Files options 
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o POS Data First File Name 
o Extracted Data Directory 
o Extracted File Name Kernel 
Note: Directories for files and Kernel are important!!! 

! POS Data extraction Time 
o All Data => Default option 
o Selected Extraction Time => Advanced option which will allow you select 

extracted Start Time and End Time (GPS Week and Seconds of Week) 
! Output 

o All groups => Default option 
o Selected group => Advanced option to select specific types. (Figure 3A) 

" Required Group:  
•  IMU Data 
•  Primary GPS Data 

" Optional Group:  
•  Events => if you want to get PosEO results 

" Recommended Group:  
•  Navigation and Dynamic Data: GPS code kinematic solution 
•  Navigation Performance Metrics: Accuracy for GPS code 

kinematic solution 
•  Sensor Navigation Data: INS free navigation solution 
•  Sensor Performance Metrics: Accuracy for INS free 

navigation solution 
 

 
Figure 3A: Group Selection 
 

! Use POS control parameter setup for post-processing: => Automatically extract all 
embedded real-time parameters, including lever arm and initial orientation 
coordinates, otherwise settings default to zero and must be entered later, manually. 

 
After all steps of data extraction are finished, the following menus can be used to examine 
the quality check or data gaps of GPS and IMU data. 
 
! “View” => “Extract Log File” 
! “View” => “POS Data” => “Sensor Data” => “IMU Data” 
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! “View” => “POS Data” => “Sensor Data” => “GPS Navigation Data” 
! “View” => “POS Data” => “Time Tagged Events” 
! “View” => “POS Data” => “Real Time Navigation Solution” => “Vehicle Navigation 

Solution (wa)” 
! “View” => “POS Data” => “Real Time Navigation Solution” => “Vehicle Navigation 

Performance Metrics” 
! “Display” => “POS Data” => “Sensor Data” => “IMU Data” 
! “Display” => “POS Data” => “Sensor Data” => “GPS Navigation Data” 
! “Display” => “POS Data” => “Real Time Navigation Solution” => “3D Vehicle 

Trajectory” 
! “Display” => “POS Data” => “Real Time Navigation Solution” => “Vehicle 

Navigation Solution (wa)” 
! “Display” => “POS Data” => “Real Time Navigation Solution” => “Vehicle 

Navigation Performance Metrics” 
! “Display” => “POS Data” => “Real Time Kalman Filter Data” => “POS Estimated 

Error and RMS” 
! “Display” => “POS Data” => “Real Time Kalman Filter Data” => “POS 

Measurement Residuals and RMS” 
 
Files created after data extraction (Table 1A) 

File # File Name File Description 
1 dephem_Kernel.dat  GPS Ephemeris Data  
2 event1_Kernel.dat  Image Time Tagged Events 
3 extract_Kernel.log   Extracted Log File 
4 gps_pri_Kernel.dat  GPS Code Kinematic Solution 
5 hwconf_Kernel.out  Hardware Configuration 
6 iinr_Kernel.out  Binary file 
7 iinz_Kernel. out      Binary file 
8 imu_Kernel.dat IMU raw data 
9 mgps_Kernel.nov Rover GPS raw data 

10 navclk_pri_Kernel.dat Clock Estimates for Rover GPS Receiver 
11 obs_pri_Kernel.dat GPS Rover Observation Data 
12 rers_Kernel.out Binary file 
13 rinv_Kernel.out POS Measurement Residuals and RMS 
14 rmrs_Kernel.out  Binary file 
15 rrms_Kernel.out POS Estimated Errors and RMS 
16 rtstat_Kernel.txt Binary file 
17 tm_Kernel.dat Binary file 
18 vnav_Kernel.out Vehicle Navigation Solution 
19 vrms_Kernel.out Vehicle Navigation Performance Metrics 

Table 1A: Files Created after Data extraction 
Note: The file descriptions for File #6, 7, 12, 16, 17 are proprietary, please contact with 
Applanix for further description. 
 

1.c. GPS solution using PosGPS 
 
POSGPS is a full-featured kinematic and static GPS post-processing package running on 
Windows 95, 98, 2000, NT and XP using Waypoint's proprietary GPS processing engine. 
! Support most single and dual frequency commercial and OEM receivers. 
! Processes GPS/GLONASS combined data. 
! Kinematic engine called Kinematic Ambiguity Resolution (KAR). 
! Forward and Backward Kalman Filter 
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! Numerous options setting 
 

1.c.1. Data loading 
 
Preparing base and rover station data, and loading into database of PosGPS 
Steps: 
! Convert GPS raw data (Rover Station) and Rinex data (Base Stations) into 

database format of PosGPS (GPB) 
Note: While converting the rover GPS raw data (mgps_Kernel.nov), the options 
“Make all epochs Kinematic” must be checked. (Figure 4A) However, for Base 
Station, the option “Make all epochs Kinematic” must be unchecked. 

! Creating a new project 
! Loading base station GPB file 

Note: Please double check the Base coordinates and antenna height. Please select 
appropriate coordinate system and the height system (Ellipsoidal Height or 
Orthometric Height). (Figure 5A)   

! Load rover station GPB file. 
Note: Leave remote antenna height as zero (offset applied in PosGPS) 
 
 

  
Figure 4A: Options for converting GPS Rover raw data to GPB format 
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Figure 5A: Coordinates for Base Station 

 
1.c.2. Data processing based on difference processing options 
 
! GPS solutions (Table 2A) 
 
For airborne dataset, Base-Rover separation is normally >10~20km, then a float 
ambiguity will be achieved. However, with the aid of ionosphere model or iono-free 
combination, a better solution (than float solution) may be able to resolve.  
 

Frequency baseline Fixed Float Iono-Free  
Short Highest accuracy Less accuracy × Single Long Max to 10-20km, Higher accuracy Less accuracy × 
Short Highest accuracy Less accuracy × Double Long Max to 30-60km, Higher accuracy Less accuracy > Float 

Table 2A: Solutions comparison in general cases for longer baselines 
 
! GPS data processing options 
 
The options for GPS data processing can be selected using the dialog box “Process 
GPS or GPS+GLONASS”. Several different tab sheets are included in this dialog box. 
 

o Process (Figure 6A) 
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# Process Direction: Both => Default, this option will allow the 
both forward and backward Kalman filter. 

  
# Process Data Type 
 

•  Automatic 
The feature automatically searches the data for dual 
frequency, single frequency or C/A code only.  If the 
master and remote files are of a different type, then the 
less of the two will be used.  The order is C/A only, 
single frequency then dual frequency. 
 

•  Single frequency carrier phase  
This will process with C/A code, L1 carrier phase and L1 
Doppler data in a combined Kalman filter.  Each of these 
data variables must be available.  Integer ambiguities can 
also be fixed using KAR, quick static or the fixed static 
solution.  Single frequency is usually less reliable than 
dual frequency and has the disadvantage of not being 
able to correct for the ionosphere.  Single frequency is 
normally always more accurate than C/A code only. 
 

•  Dual frequency carrier phase 
For GPS receivers that track L2 carrier phase, processing 
dual frequency has two benefits.  Integer ambiguity 
resolution (e.g. KAR, fixed solution and quick static) is 
much more reliable, and the resolution time is much 
faster.  For instance, KAR using dual frequency data can 
resolve in a few minutes what could take 10-20 minutes 
in single frequency.  Secondly, ionospheric correction 
can be enabled with dual frequency data.  This greatly 
improves accuracies on baselines longer than 10 km.  
Please note that processing dual frequency on single 
frequency data will have no benefit, and may have 
adverse effects. 
 

•  C/A code only (DGPS) 
This will process in an advanced differential correction 
mode.  In kinematic mode, the accuracy will be the same 
as real-time differential (i.e. RTCM corrections).  In 
static mode, the accuracy will be higher due to averaging 
effect.  Normally, C/A only processing is only performed 
for data with no (or incomplete) carrier phase 
information. 
 

•  Occupation mode 
This is a special mode of operation designed for use in 
high tree cover areas.  In this mode, the user should stay 
stationary over each point for 2-5 minutes.  Carrier phase 
lock need not be maintained during travel between points.  
Since the carrier phase is used in static mode (not 
kinematic) sub-metre accuracies can be achievable in 
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such terrain.  GLONASS processing is also suggested to 
add additional satellites. 
 

# Static Initialization 
 

•  Float solution or kinematic initialization 
The float solution does not solve for integer ambiguities.  
This setting is also necessary for kinematic initialization.  
Since integers are not solved, the float solution tends to 
be less accurate than the fixed or quick static solutions.  
For longer baselines (>10 km in single frequency and 
>30-40 km in dual frequency) integers are often not 
solvable.  In such cases, the float solution is often the 
best alternative.  For dual frequency, be sure to enable 
the ionospheric free correction mode from the Dual 
Frequency Options. 
 

•  Fixed static solution 
This method processes carrier phase in order to obtain a 
static fixed integer solution.  If the integers are correctly 
determined, this mode is the most accurate.  For longer 
baselines, an ionospheric correction is applied to the 
fixed solution.  For single frequency, a minimum of 10 
minutes is required and 15 minutes is suggested. For dual 
frequency, only a few minutes will work.  However, 
users often choose to stay longer to lessen the likelihood 
that a point be re-observed. Note that time should be 
increased with baseline lengths for both single and dual 
frequencies. 
 

•  Quick static solution 
Uses integer ambiguity techniques to quickly resolve 
baseline coordinates.  This is an out-dated methodology.  
This feature is only retained in the software since there 
are a few instances when it will deliver a solution where 
the fixed solution will not.  The quick static solution is 
normally not as reliable or as accurate as the fixed 
solution. 
 

# Kinematic Ambiguity Resolution (KAR) 
 
Kinematic Ambiguity Resolution (KAR) is the process of solving  
fixed integers on a moving antenna.  KAR will also engage in static 
mode if the 'Engage KAR in STATIC mode' setting is enabled in the 
KAR Options.  KAR is very useful to regain integer (high accuracy) 
positions at onset or after a loss of lock.  KAR requires 5 or more 
satellites and 6 satellites are suggested. 
 

•  Automatically 
KAR is enabled for dual frequency and disabled for 
single.  KAR is not applicable for C/A only processing. 

•  Off 
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This forces KAR to never be engaged. 
•  On 
•  Manual engage only  

It only engages KAR at times specified in the Advanced 
KAR options.  KAR will not be engaged if there is a loss 
of lock. 
 

# GPS+Glonass Processing 
 
Normally, POSGPS will automatically detect if there is GLONASS 
data.  However, if this detection fails or if the GLONASS data is 
causing problems, then satellite system type may need to be selected 
(i.e. GPS Only or GPS+GLONASS). 
 

•  Automatic 
•  GPS Only 
•  GPS+GLONASS 

 
 

 
Figure 6A: Process for “Process GPS or GPS+GLONASS” 
 
o General (Figure 7A) 

 
# Elevation Mask  

The default elevation cut-off for satellite processing is 10 degrees.  
You may wish to raise this to 15 degrees, but we do not suggest 
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that you lower it.  If the default is set too high, you may miss 
satellites that are important to the geometry of the position.  
Lowering the mask can cause a solution degradation due to noisy 
data. 
 

# Processing Interval 
The program automatically lines up both the master and remote 
data sets at the data collection rate.  If this is not desired, you 
may specify the interval at which you wish to process the data.  
For instance, in static mode, processing with data intervals 
shorter than 15 s is not beneficial.  In fact, it can result in overly 
optimistic accuracy estimates. 
 

# Time Range  
Normally, POSGPS will process the entire data set.  This means 
starting at the first epoch the master and remote has in common 
and ending at the last.  Users may, however, wish to limit the 
scope of processing to avoid problematic time periods.  Such 
time periods are usually isolated from the data plots.  The 
beginning and end times are entered here.  These times are for 
forward processing (i.e. begin time is before end time).  For 
reverse processing, POSGPS starts at the end time and stops at 
the begin time  The default time system is GPS seconds of the 
week (0-604800), but times can also be entered in hours, minutes 
and seconds.  These are in the GMT time zone. 

 
# Process Direction  

Use this option to process data sets in the forward, reverse or 
both directions.  Both directions will process the forward first, 
followed by the reverse. 
 

# Write Satellite Residuals 
These are needed for graphing individual satellite residuals.  
Forward only processing is highly suggested for analyzing 
satellite residuals, as the plotting functions can sometimes be 
confused by the reverse files. 
 

# Processing Datum   
Normally, the processing datum is the same as that where your 
base station coordinates are referenced to.  In this case, select the 
processing datum from the list.  Alternately, processing can be in 
a global datum such as WGS84, and coordinates can be entered 
in the local datum. 
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Figure 7a-A: General for “Process GPS or GPS+GLONASS” 
 
o Advanced  
 

# Base Satellite 
This is the satellite initially used as the base for the differenced 
observations. 

 
# Satellites to Omit  

Normally, all satellites are used for processing.  You may wish to 
omit satellites which have serious data problems.  They will be 
noted in message log file.  Satellites can either be omitted for the 
entire data set or for a selected time period.  Minimizing the 
extent of an omission is always preferred. 

 
# Tropospheric Model 

Tropospheric corrections should always be used.  POSGPS uses 
the Saastamoinen model as experience has shown that it works 
best.  The 'Off' setting is to be used with simulator data where the 
tropospheric correction has been disabled. 

 
# Carrier Locktime Cut-off 

The number of seconds of carrier phase lock before data for that 
channel is deemed usable.  This allows users to reject data for the 
first 'n' seconds since loss of lock.  The default value is 4, but 
higher numbers (8-12 s) can be very beneficial to some GPS 
receivers—especially low-cost ones. 

 
# L1 Phase Cycle Slip Detection & Tolerance 
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These parameters govern how POSGPS detects cycle slips.  In 
general, POSGPS relies on a procedure of using the locktime 
read or computed in the decoders combined with a Doppler 
check.   
 

•  Doppler 
The Doppler check tries to predict the L1 phase using the 
Doppler and compares to the actual value.  Using zero as 
a tolerance lets POSGPS choose a value based on the 
interval. 

•  Locktime counter 
The locktime cycle slip check uses flags generated by the 
GPS receiver.  This should normally always be enabled. 

•  Static fine check  
In static mode, the fine static check should be turned on. 
This allows POSGPS to detect very small cycle slips and 
is now by default ON. For the fixed solution, this is 
automatically used and cycle slips are also corrected.  

•  Skip serial drop-outs   
This should only be used for data sets that are susceptible 
to individual satellites skipping in and out due to serial 
data errors.  Ashtech MBN, MPC an MCA records are 
the most susceptible.  Some download (B-files) from 
Ashtech have also been observed exhibiting these 
phenomena.  For receivers other than Ashtech, there 
should be no reason to use this option. 

 
# Bad Data Control 

 
•  Reset filter   

The filter reset is a safety measure in the processing 
engine that prevents bad data from permanently harming 
the ambiguity values.  This feature should protect carrier 
phase processing from ever being worse than DGPS.  
The filter reset is engaged when an unfixable carrier 
phase error has been detected, and induces a total loss of 
lock on all satellites.  However, in some cases a small 
cycle slip is not as serious as the compensating measure 
(i.e. the filter reset).  In such cases, disabling this feature 
may result in a better quality solution, especially for 
single frequency data sets. 

 
•  Write epochs containing bad data 

This command forces POSGPS to print out all positions 
that it computes, regardless of whether it has deemed the 
data to be good or bad.  By default, POSGPS will not 
print positions for epochs for which the Kalman filter has 
detect large measurement errors.  This option should 
only be used if you need a position for as many epochs 
as possible, and if you are not concerned about some low 
quality positions. 
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•  Do not write epochs with poor statistics 
This option allows you to remove epochs from a solution 
that have quality numbers, or standard deviations greater 
than some threshold.  This option can be used to attempt 
to filter out bad positions from the output. 
 

# FWD/REV File Format 
This option allows you to select the format of the epoch output 
files. The Normal format is the format that POSGPS uses by 
default.   

 

 
Figure 7b-A: Advanced for “Process GPS or GPS+GLONASS” 
 
o Dual Frequency (Figure 8A) 

 
POSGPS supports full dual frequency processing.  For this feature to work, 
both the master and remote receiver must be dual frequency GPS receivers. 
By making measurements on both L1 and L2, the ionosphere error can be 
resolved.  The effect of the ionosphere under normal conditions and in the 
absence of ionospheric storms is a small effect at 0.5 - 2 PPM (5-20 cm per 
100 km).  Because L1 and L2 carrier phase need to be combined to remove 
the ionosphere, the measurement noise will increase from sub 1 cm to 1-3 cm. 
A further problem occurs because L2 is more prone to cycle slips.  For the 
ionospheric-free model, a cycle slip on L2 will induce a total cycle slip for 
that satellite. For the relative ionospheric model, this is not the case making it 
less sensitive to L2 slips.  However, this adds additional noise to the solution, 
which can sometimes cause the relative model to be less accurate.  Generally, 
ionospheric correction becomes beneficial on baselines greater than 10 km. 
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Another good reason for employing dual frequency is to improve the 
reliability of integer ambiguity search techniques.  By combining the L1 and 
L2 carrier phase the so-called widelane is formed.  These techniques are 
employed for Quick Static, Fixed Static and Kinematic Ambiguity Resolution 
(KAR).  The result is that these techniques will work much more reliably, 
solve on longer distances and require less observation time. 
 

# Use P2-Code in Kalman Filter  
Under normal circumstances P2-code measurements are not 
employed.  This is because most dual frequency receivers use 
narrow correlators (or similar technology) for their C/A code 
measurements and these tend to be more robust and reliable than 
the P2-code.  Enabling this feature will add this measurement to 
the Kalman Filter thereby causing a faster convergence. 
 

# Use L2 for Ambiguity Resolution   
It is important for this feature to be enabled when using Quick 
Static or KAR as it allows widelaning to be used.  There is no 
reason for disabling this option.  In such a case, it is better to use 
single frequency processing. 
 

# Use L2 for Ionospheric Processing  
 

•  Relative Ionospheric Model 
This is normally used when static initialization occurs 
when the base and remote are close and the ionospheric 
error at that base-remote separation can be assumed to be 
zero.  Using the relative transfer algorithm, the 
ionospheric error is accumulated as the base and remote 
get farther apart.  The distance from the base station 
when the relative transfer starts can be set using the 
Engage Distance.  If loss of lock occurs, then this 
ionospheric transfer cannot continue.  After this point, 
this solution becomes very similar to the ionospheric free 
model.  Because of this last feature, the relative model 
can be used even if the starting point is far from the base.  
Since the relative model is less sensitive to the noise of 
L2 data. 

 
•  Engage Distance for Relative Ionosphere 

This parameter is combined with relative ionospheric 
processing and it sets the radius from the base station 
before the relative ionospheric correction starts.  This is 
an advanced parameter and changing it will cause little 
difference in the final solution.  Users may wish to lower 
this value during periods of high ionosphere activity. The 
default value is 4.0 km. 
 

•  Ionospheric Free Model 
This can be used for static or kinematic data processing.  
The Iono-free solution will do a better job of resolving 



High-Accuracy Direct Aerial Platform Orientation with Tightly Coupled GPS/INS System 
 

31 

 

the ionospheric error at the expense of being more 
susceptible to cycle slips.  Static baseline should only use 
this method. 

   
Note: For choosing between Iono-Free and Relative Iono 
Models there are several rules of thumb: 
 
1) If the L2 data is very clean with minimal losses of 

lock, then the iono-free model often works better. 
2) If the L2 data is continually losing lock, then the 

Relative model can be better. 
3) The relative likes to start close, but it is not 

necessary.  In many cases both models will give 
similar results. 

4) It is also often a good idea to try both models.  
Sometimes one will work quite a bit better than the 
other. 

5) Iono-free should be used in static.  It will aid the 
fixed static solution if the iono noise model is used. 

 
# L2 Small Cycle Slip Tolerance 

Both KAR and relative ionospheric processing check for small 
cycle slips on L2 by checking it against the L1 phase.  Raising 
this value too high will increase the chance of a half cycle slip 
being detected.  Lowering this value may cause false cycle slips 
to be induced by noise.  Changing this value requires analysis of 
the results and should only be done by advanced users. 

 
# Correct C/A code for Ionosphere  

By combining the C/A code and the P2-code, the ionospheric 
effect can be removed from the pseudorange measurement.  
However, this adds additional noise along the lines of a few 
metres.  Thus, baselines need to be very long before the effect of 
the ionospheric is larger than the additional noise induced.  
Generally, baselines need to be 500 km or more in length. 
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Figure 8A: Dual Frequency for “Process GPS or GPS+GLONASS” 
 
o Standard Deviation (Figure 9A) 
 
This dialog box allows the user to change some of the parameters used in the 
double difference Kalman filter.  These settings control the weighting of the 
carrier phase and pseudorange (C/A code) measurements in the Kalman filter.  
The following statements normally apply: 
 
1) Using accurate standard deviation values results in better float solution 

convergence.  For float-mode processing, accuracies can sometimes be 
significantly improved.  For fixed-integer processing, KAR resolution is 
generally faster, but the actual accuracy is not usually affected. 

 
2) Lowering the C/A code standard deviation with respect to the carrier 

value causes the software to converge faster.  If the C/A is over-weighted 
(i.e. standard deviation is too low), then it may converge to the wrong 
value. 

 
3) The best way to evaluate optimal standard deviations is to use the Plot 

GPS Data function from the Output Menu.  View the RMS-C/A code and 
RMS L1 Phase.  Good standard deviation values are those where 90-95% 
of the RMS values fall below user-defined threshold.  The values 
computed from the Processing Summary (under the Process Menu) can 
often be optimistic. 

 
4) If the standard deviation is altered, the rejection tolerance should also be 

changed.  Generally, the rejection tolerance for the C/A code should be 3-
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4 times the standard deviation.  For the carrier phase, the rejection 
tolerance should be 5-6 times. 

 
5) Raising the carrier phase rejection tolerance is a useful way to making the 

Kalman filter less sensitive to noisy data.  For airborne processing, 0.20 
m can often result in better accuracies. 

 
6) Note that the PPM value is added to the carrier rejection tolerance to 

account for the additional noise induced by the ionosphere. 
 
7) Sometimes very bad Doppler data can induce position errors.  POSGPS 

tries to protect against this, but this phenomena can still happen.  In such 
a case, raising the Doppler standard deviation is a good remedy. 

 
# Standard Deviation 

By default the C/A code is set to 7.0 metres.  This is to account 
for possible multi-path on the C/A.  However, if the C/A code 
measurements are quite clean then this number can be lowered to 
1-3 metres.  This will improve kinematic convergence times for 
the float solution.  As for the carrier phase standard deviation, 
this should be left at 2 cm for most applications except for 
airborne data over longer baselines.  3-5 cm with a 20 cm 
rejection tolerance seams to be more proper for this type of data. 
If there are problems with the Doppler (phase rate) measurements, 
then the user may wish to raise the L1 Doppler standard 
deviation (to 1-5 m).  The default value is 25-100 cm depending 
on the GPS receiver type. 

 
# Rejection Tolerance 

This refers to the tolerance on the residuals over which the 
measurement will be assumed erroneous.  The default values are 
10 cm for L1 phase and 25 metres for C/A code.  The L1 phase 
tolerance is also increased by the parts-per-million (PPM) value 
to account for ionospheric noise.  The user may want to raise the 
L1 tolerance value to allow more leniencies for bad L1 phase 
measurements.  This is closely associated with the reset filter flag 
in the advanced options.  The default code rejection tolerance of 
25 m is very forgiving.  Users may wish to lower this value to 
reduce the number of poor pseudorange measurements that may 
bias the Kalman filter.  Caution should be taken when lowering 
rejection tolerances too much.  This is because if POSGPS 
cannot resolve which satellite is the problem, it will induce cycle 
slips on all satellites. 
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Figure 9A: Standard Deviation for “Process GPS or GPS+GLONASS” 

  
 
o Fixed Static (Figure 10A) 
 
This is for static data processing. 
 

# Search Area Options: 
•  Normal  

This is the default search area, which is a constant search 
region size. 

•  Reduces as float solution accuracy improves 
An auto-reducing search area is helpful for situations 
where the fixed solution is failing the reliability tests.  
Normally, this would be the case on short baselines, 
possibly with single frequency measurements. 

•  User defined search cube size 
A user defined search area is not often used.  However, if 
the float solution is known to converge very close to the 
correction solution, then enter zero here. 

# Ionospheric Noise Modeling 
This noise model corrects for the ionosphere in its computation.  
This can improve accuracies, but noise might be higher on short 
baselines. 

•  Automatic 
This noise model chooses between Normal and Iono 
based upon the distance tolerance given. 
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Figure 10A: Fixed Static for “Process GPS or GPS+GLONASS” 
 
o Kinematic Ambiguity Resolution (KAR) (Figure 11A) 
 

Kinematic Ambiguity Resolution (KAR) is a technique that allows the 
user to compute an integer fixed solution (i.e. 2 cm accuracy) while the 
remote antenna is in motion.  Typical applications would be kinematic 
initialization in marine environments and initialization after loss of lock. 
A KAR solution that uses dual frequency data is considerably more 
reliable than if only single frequency data is available.  This is due to the 
additional measurements present with the L2 phase.  However, KAR can 
deliver accurate results with single frequency, it just takes longer.  
Secondly, both single and dual frequency KAR requires at least 5 
satellites.  If KAR fails after a given length of time, then it starts 
searching over again. 

 
KAR may skip some data after loss of lock, but it will try to go 
backwards as far as possible.  The .FSS or .RSS file (Static/KAR 
summary) will show when KAR was engaged and when it was restored.  
Additional KAR statistics will also be shown here. 
 

# Minimum Time 
•  Single Frequency 

This is the minimum amount of time before KAR is 
invoked.  The default value is 8 minutes.  

•  Dual Frequency 
This is the minimum amount of time before KAR is 
invoked in dual frequency mode.  The default value is 
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1.0 minute.  Users may wish to lower this value for urban 
data sets where fast ambiguity determination is very 
helpful.  Longer baseline airborne users may with to 
increase this number to minimize the effect of the 
ionosphere. 
 

The value to the right is added to the time for every 10 km 
that the remote is from the base.  For instance, if a dual 
frequency receiver is used, and the base-remote separation is 
20 km, then the overall minimum time will be 1.0 min + 2.5 
min*20/10 = 6 minutes. 

 
# Maximum Time 

This is the time length before KAR will start searching over 
again.  Lowering this value can cause fixed integer gaps to be 
lower. However, KAR will be prevented from using more data 
than indicated. This is more practical for dual than single 
frequency because single frequency KAR often needs 15 or more 
minutes to resolve.  The default value is 30 minutes, and this 
value is normally left 'as is'.  
 

# Search Region Size: 
•  Single Frequency 

This is the size of the search area for single frequency 
KAR.  Because the single frequency KAR is invoked 
after 8 minutes or so, this value can be quite small.  The 
default value is 1.0 m.  Valid values range from 80 cm to 
1.2 m. 

•  Dual Frequency 
For dual frequency KAR, there are two ways to 
determine the search area: 
" Use a fixed search range (e.g. 4.0 m by default).  

This value is often lowered to 2-3 m to speed up 
KAR resolution time 

" Auto-reduce, which means that the covariance 
information is used for search area estimation.  To 
ensure that the entire search area is encompassed, 
the ambiguity standard deviation is multiplied by a 
factor (e.g. 3).  If a user feels that the standard 
deviations are overly optimistic, then raising this 
factor can be helpful.  

 
# Options for Engaging KAR 

KAR will not engage if the remote is too far from the base.  This 
improves reliabilities.  The distance tolerance for engaging KAR 
in both single and dual frequency is defined here.  Normally, the 
maximum allowable distance for single frequency is 7.5 km, 
while for dual frequency it is 30 km.  These values are designed 
for a period where the ionospheric activity is high (i.e. year 2000).  
In subsequent years, these tolerances can be lengthened.  This 
option (i.e. 'Maximum engage distance') only controls when 
KAR is started.   
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Normally, KAR will not engage in static mode.  This is to allow 
static processing methods to take precedence.  However, for 
users that wish to engage KAR in static, the option 'Engage KAR 
while in STATIC mode' should be enabled.  Please be sure not to 
combine this with either the fixed static solution or the quick 
static solution, as problems may develop. 

 

 
Figure 11A: KAR for “Process GPS or GPS+GLONASS” 
 
o Advanced KAR (Figure 12A) 
 

# Advanced Setting 
 

•  Stricter Reliability Tolerance 
The reliability is the ratio of the carrier RMS values 
between the second best and best intersections.  Larger 
values indicate increased reliability.  The tolerance for 
accepting a reliability number is dynamic within 
POSGPS.  Enabling this checkbox will apply a more 
stringent tolerance.  Basically, 0.5 is added to the 
existing dynamic tolerance.  This setting would be used 
to reduce the occurrence of incorrect KAR intersections.  
The reason that users may not wish to use this all the 
time is that it can cause to KAR to take longer to resolve 
ambiguity or sometimes not resolve ambiguity at all. 
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•  Stricter RMS Tolerance 
This option is similar to the above except that it applies a 
lower tolerance to the RMS value of the best intersection.  
The tolerance, normally 0.065 cycles, is lowered to 0.05 
cycles. Like before, setting this will reduce incorrect 
KAR intersections.  In fact, of the two, this feature is 
usually more effective.  Some users may wish also to use 
both. 

 
•  Use Distance Weighting 

KAR has the ability to weight by the inverse of the base-
remote distance (baselines shorter than 6 km will not be 
affected).  This is helpful for airborne data as the effect 
of the ionosphere is distance dependent.  By default, this 
setting is on. 

 
•  Use fast KAR 
•  Use fast KAR even for 5SVs 

If very fast KAR resolution is selected, then minimum 
time is greatly reduced, but it will reduce the reliability 

 
•  Refine L1/L2 KAR search 

 
# Geometry (DD_DOP) Settings 
 
These settings control how KAR reacts to poor satellite geometry.  
Note that KAR uses the DD_DOP for testing.  The DD_DOP is 
approximately PDOP^2, but can be somewhat lower due to the 
differential implementation. 

 
•  Maximum Allowed DOP 

KAR will not search if the DD_DOP is greater than this 
tolerance.  This is to preserve the reliability of the 
solution.  KAR solutions with high DOPs can be 
unreliable.  However, raising this value allows KAR to 
search where otherwise the software would skip past this 
data.  The default value is 9.0. 

•  Engage on Poor DOP 
The number of cycle slip free satellites to maintain lock 
is four.  In some cases this minimum is maintained, but 
the geometry of these satellites is very poor.  This can be 
seen as a spike in the DD_DOP plot.  Setting this 
checkbox will engage KAR after the DOP recovers from 
being very poor.  The default tolerance is 25, but users 
may wish to increase or decrease this to control how 
KAR reacts at a poor DD_DOP.   

 
# Data Usage Settings 

 
•  Use on interval 

This defines how many seconds between epochs that 
KAR will use for processing. Generally, if carrier phase 
errors are random (i.e. white noise), then using a lower 
interval will improve results at the expense of memory 
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usage and computational time.  If errors are systematic 
(i.e. colored/ionospheric noise), lowering this value will 
help little. 
 

•  Exact interval (for interpolating data) 
GPS data can be interpolated with the 'Concatenate, Slice 
and Resample' utility or using the 'Download Service 
Data' feature.  In either case, additional errors of 1-2 cm 
can be added to measurements, which is sufficient to 
cause KAR not to work.  However, if the 'Exact Interval' 
check box is enabled and the data interval 'Use on 
interval' has been set to the original source data interval 
(e.g. 30 s), then KAR will not be affected.  Users may 
also wish to lengthen the minimum KAR time (KAR 
Options) to use more data, as one point every 30 s is 
quite sparse. 

 
# L2 Noise Model for KAR 
 
KAR supports a number of L2 noise models, which model how 
POSGPS handles L2 data in dual frequency KAR.  Due to anti-
spoofing, L2 can be significantly noisier than L1 and this difference 
must be taken into account. 
 

•  High 
It is more robust and is less susceptible to ionospheric 
noise. 

•  Ionospheric correction 
This noise model corrects for the ionosphere, and seeds 
the ionospheric correction algorithms forming a more 
accurate KAR fix. 

•  Medium 
There should be few cases where it performs better than 
the new high noise model. 

•  Low  
The low noise model places more weight on L2.  It 
normally does not perform as well as the previous noise 
models, but for short baselines it may be helpful. 

•  Automatic 
The automatic noise model is the default, and it chooses 
between the High and the Ionospheric correction noise 
model depending on the current distance.  The distance 
tolerance is specified in the dialog box. 

 
# Manual KAR Engage 

 
Users can manually engage KAR at times that they feel it is 
necessary.  For instance, there may be a perfect time when an 
airborne platform is very close to the base.  In such a case, also 
consider lowering the minimum KAR time.  The user must specify 
the time of engagement as well as the process direction.  This feature 
works well combined with the process KAR (Manual Only) setting in 
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the Process Settings.  This will allow KAR to only be engaged when 
selected by the user. 
 

 
Figure 12A: Advanced KAR for “Process GPS or GPS+GLONASS” 

 
o Glonass (Figure 13A) 
 
The GLONASS options govern the way POSGPS will use GLONASS 
measurements when computing a solution 
 

 
Figure 13A: GLONASS for “Process GPS or GPS+GLONASS” 
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1.c.3. Recommended options and potential problems for  Airborne Datasets 
 
As for airborne dataset, Base-Rover separation may be longer, normally >10~30km, 
the following options and tips should be considered. 
1) Combine Forward and Reverse Solution 
! The forward/reverse combination is a fast and easy check of the solution internal 

quality. 
! The magnitude of the forward/reverse separation gives an indication of the 

reliability of the solution. 
 
2) Use Static/Kinematic Flag 
! Take advantage of the static part dataset to initialize GPS ambiguity if static part 

exists. 
! Static part can be detected to check velocity estimation from float solution. 
 
3) Processing Long Kinematic Baselines  
! Use L2 for ionospheric processing 

o Ionospheric free Model: It works well when the remote initializes far 
from the base. However, a cycle slip on L2 will induce a total loss of lock 
for that satellite. 

o Relative ionospheric model: It works by only applying an ionospheric 
correction to the L1 signal and tends to have a higher L1 phase error than 
the iono-free, since it is only an approximation. However, cycle slips on 
L2 does not reset the ambiguity like the iono-free model. Hence, 
accuracies may be better if L2 cycle slips are present in large quantities. 

! Use L2 for ambiguity resolution 
! Use P-Code for Kalman Filter: C/A code can be corrected if P2 code is available.  

In many cases, this will simply add more noise, but the noise is very white, and 
overall improvements can be observed.  It is often good to try with and without. 

 
4) Eliminate problem satellites 
! Detect problem satellites according to message logs or satellite residuals. 
! Eliminate the problem satellites for the whole dataset or specific time periods. 
Note: If the option "reset filter at unfixable bad data"  is on (found in the Advanced 
Option tab of the processing options), large spikes may appear in every SV plot.  
Examining which satellite is the worst offender (that is, which has the largest satellite 
phase residuals) just prior to the filter reset, and omitting these satellites (up to just 
after the total loss of lock) will often not result in the total loss of lock induced by the 
filter reset option, and improve results considerably. 
 
5) Set the proper standard deviation for kinematic convergence. 
! Determine new standard deviation (C/A, P, L1, L2) according to the residual of a 

float solution. 
! Modify the rejection tolerance according to the modification of new standard 

deviation. 
 
6) Filter Reset in Kinematic Single Frequency 
! The filter reset option can have a tremendous effect on accuracies. 
! The filter reset will a cycle slip on all satellites if a small cycle slip has detected 

(since it cannot isolate which satellite the cycle slips happened on). Then, this 
small cycle slip may be left in the data.  
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! It is best to process once with this option on, combine the forward and reverse.  
Then process once without this option and combine.  Use the one where the 
forward/reverse separation is lowest. 

 
7) Processing Kinematic Data from Multiple Base Stations 
! PosGPS does not support multiple base station data processing. 
! Alternative approach.  

o Run forward/backward solution with one base station 
o Run forward/backward solution with another base station 
o Combine forward/forward or backward/backward solutions from two 

base stations. 
o Choose the best pair based on minimum combined forward/reverse 

separation, combined RMS, and combined position standard deviation. 
 
8) Avoiding Missing Epochs 
! Locktime cut-off option can ignore the first several seconds of data after a 

satellite rises. 
 
9) Detecting and Fixing Incorrect Integer Intersections by KAR when it picks the 

wrong solution 
! Check “combined forward/reverse separation”: => A near constant offset or poor 

performance in the combined forward/reverse separation. 
! Check “Float/Fixed Ambiguity Status”. 
! Compare fixed ambiguity solutions with float solution (difference and position 

standard deviation), to find which fixed solution is wrong. 
! Processing direction of bad solution: => plot the L1 Phase RMS for each 

direction, the incorrect fix normally exhibits a linear growth to the carrier phase 
RMS 

! Another way to determine the likelihood of a bad KAR fix is to view the 
Static/KAR summary file (.fss/rss).  There will be records for each KAR fix.  
Look for fixes with poor RMS (>0.05 cycles), low reliabilities (<2-3) and/or large 
float-fixed separations (>1 m). 

! Correcting the Problem caused by a bad KAR fix is normally a very easy problem 
to correct.  It just requires one or more of the following settings to be changed.  
The first ones are more likely to help then the last. 

o Lengthen the minimum KAR time.  As KAR uses more time, it usually 
rejects bad fixes better. 

o Enable the 'Stricter RMS tolerance' and/or the 'Stricter reliability 
tolerance' checkboxes in the Advanced KAR options. 

o If the auto-reduce KAR search area is used for dual frequency, try 
increasing the scale factor. 

o Use the KAR_SEP_TOL command to force KAR to only accept 
intersections that are close to the float solution.  For instance, use a value 
of 1 m). 

o Lower the Maximum Engage Distance for KAR.  Users may also wish to 
use the KAR_USE_DIST command and set the distance to a lower value 
as well. 

o If poor geometry is a concern, try lowering the 'Maximum allowed DOP' 
from the Advanced KAR Options. 

 
10) KAR – Improving upon a 20-30 cm combined separation 
! For long baseline airborne processing, this will be ok, however, it also may be 

improved 
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! Try both the Iono-free, relative models and combinations for forward and reverse. 
! Enable the 'Engage KAR after poor DOP' option under the Advance KAR 

Options.  This will be helpful if large DOPs are observed (plot the DD_DOP 
variable where DD_DOPS over 15-25 can cause instabilities).  You may also 
need to check the message log file, as epochs with extremely poor DOPs are 
skipped and not visible on the data plots. 

! Increasing either the KAR time or the KAR add time (i.e. #min/10km) can help 
as well, since KAR can sometimes pick the wrong L1 or L2 lane resulting in a 
10-20 cm error. 

! Try enabling the stricter RMS tolerance check box in the Advanced KAR Options.  
This will make KAR less likely to accept a bad solution. 

! Try forcing the use of the Iono L2 noise model (or lower the Auto distance) in the 
Advanced KAR options.  This causes ionospheric corrections to be more properly 
estimated. 

! Try lowering the carrier PPM rejection (see Standard Deviation Options) to 0.5 or 
0.25, as this makes the error rejection routines more sensitive.  This is not always 
beneficial, but it is worth a try if nothing else helps. 

 
11) Using KAR With Interpolated Data 
! If the Download Service Data function was used to download CORS or IGS data, 

you have the option of interpolating to a higher interval.  In such a case, the 
epochs not on the original interval (usually 30 s), has errors of ~1 cm.  If KAR 
uses this data, it will often fail.  Therefore, under the Advanced KAR options, set 
the 'Use on interval:' value to the original data interval of your data (e.g. 30 s).  In 
addition, enable the 'Exact interval (for interpol. data) option.  This will cause 
KAR to only use the data on the exact 'n' second interval.  The minimum KAR 
time may need to be increased to compensate for less data being used by KAR. 

 
12) L2 noise modeling 
! High Noise model: => Less reliant on L2, reliable if L2 is noisy 
! Iono Noise model: => Seeds the iono-free and relative ionospheric models, this 

can produce a more accurate final solution. Not only removes ionospheric error to 
improve reliabilities, but it also seeds the ionospheric correction (when engaged). 

! Auto Noise model: => Chooses between the High and Iono noise models based 
upon the distance when the search is performed. The distance tolerance for 
choosing between the two noise models (i.e. High and Iono) can be specified in 
the Advanced KAR Options.  In most cases the Auto setting works best.   

 
13) KAR options – could not find a solution 
! Resolving this problem is usually more difficult than resolving the problem of 

picking a wrong solution.  This is because the inability to pick a solution is most 
often related to noisy carrier data on L1 and/or L2.  Usually, playing with the 
KAR time and search region size is all that can be done.   

! For dual frequency, switching to other noise models can help if there is a problem 
with L1 or L2.   

! For dual frequency GPS data with good C/A code, set the C/A standard deviation 
to 2-3 meters.   

! Change the size of the KAR Dual Frequency Search Region size to 1.5 meters.  
Use KAR Options. 

! Raise the KAR Minimum Time for Dual Frequency to 3 or more minutes.  Use 
the KAR Options as well 

! From the Options Menu, select User Defined Options.  Enter the command: 
KAR_SEP_TOL=0.75 
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! For single frequency KAR, the L1 phase needs to be very clean, and there has to 
be a period of at least 10 minutes without a loss of lock.  These conditions are not 
always possible in many environments. 

 
Note: Using this above procedures will help in finding a solution but may increase the 
chance of a false intersection as well.  Therefore, it is important that FWD/REV 
solutions agree. 
 
1.c.4. Export results of PosGPS to PosProc 

 
“Output” => “Export to PosProc” (Figure 14A) 
 
Results are exported to the PosProc module for further processing. 
 

 
Figure 14A: Export to PosProc File 
 
1.c.5. Other potential solutions if invalid or no solution for PosGPS is obtained 
 
! Try other GPS kinematic software, for example, Trimble Office, Trimble Total 

Station with VRS, Javad Pinnacle, Laika SKI, or other GPS software package 
supporting multiple base stations. 

! Generate output according to format of PosGPS. (Table 3A) 
 
File Name: gps_pri_Kernel.dat 

Column Data Description Unit 
1 Time GPS Week Second 
2 Latitude Deg 
3 Longitude Deg 
4 Height Meter 
5 Velocity North Meter/sec 
6 Velocity East Meter/sec 
7 Velocity Height Meter/sec 
8 Standard deviation East  Meter 
9 Standard deviation North Meter 
10 Standard deviation Height Meter 

Table 3A: File format for GPS Solution output file. 
 
Note: Normally, the outputs of traditional GPS software package don’t include the 
velocity estimation, and then the velocity column can contain any value (double) put 
by the user. However, in the following step “IIN Kalman Filter”, the velocity 
measurement must be excluded. 
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1.d. IIN (Inertial Integrated Navigation) Kalman filter using POSProc SBET 
 

1.d.1. IIN filter setup (Figure 15A) 
 
! “Setup” => “IIN Filter” 
The Kalman Filter setup window enables entry or editing of Kalman filter parameters 
which normally are not recommended to be modified from their default values.  
 
! Editing Kalman Filter control parameters and values: 

o Prefilter Interval: specifies the iteration (repeat) interval of the averaging 
prefilter. The default value is 1 second. 

o Kalman Filter Interval: specifies the iteration interval of the Kalman filter. 
It must be an integer multiple of the prefilter interval. It can be equal to 
the prefilter interval, in which case the Kalman filter processes each 
constructed measurement, i.e. measurements are not averaged. The 
default value is 1 second. 

o Measurement Residual Ratio: specifies the ratio of the computed residual 
with the RMS residual used by the Kalman filter measurement residual 
test to accept or reject constructed measurements. The default value is 3.0 
which implies that a measurement residual that is 3 times the Kalman 
filter predicted RMS residual is rejected, i.e. not processed, on the 
assumption that one or more of the data items used in the constructed 
measurement are bad. Selecting larger values risks the inclusion of bad 
data. 

o Exit after (default = 50) consecutive measurement rejections: The 
consecutive measurement rejections feature ensures that periods of data 
abnormality are identifiable and absolutely excluded. 

 
! Measurements Sheet: Estimated measurement accuracy for selected aiding data. 
 

o Coarse and Fine Alignment: Some state and measurement parameters can 
have different values for the coarse and fine alignment error models. 
These include all system state process noise spectral densities, 1st order 
Markov state correlations times and all measurement noise standard 
deviations.  

o Adaptive/Fixed/Means RMS: Some measurements, notably those 
constructed from GPS position, velocity or attitude data, can be 
configured to use the RMS error included with the data. This is called 
adaptive measurement noise parameterization. Selecting Adaptive RMS 
enables the Kalman Filter to recognize and use embedded values. Also it 
will enable adaptive measurement noise parameterization. Select a 
measurement noise (Means RMS Scale) scale factor (default is 1.0). The 
Kalman filter multiplies the RMS error provided with the data by the 
specified scale factor and then selects the maximum of the scaled RMS 
error and the measurement noise RMS parameters specified in the edit 
boxes. The specified measurement noise RMS parameters become lower 
bounds on the measurement noise RMS that the Kalman Filter uses. 
Click on Fixed RMS to disable adaptive measurement noise 
parameterization. In this case the Kalman Filter ignores the RMS error in 
the data and uses the specified measurement noise RMS parameters as 
given. 

 
! North, East, Down, X, Y, Z, SIN, COS Measurements: 
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Figure 15A: IIN Filter Setup 
 
 
1.d.2. Data processing 
 
“Run” => “Proc” => “SBET” (Figure 16A) 
 
System will automatically detect the quality of GPS solution (C/A, P, CD, FD, ID), 
and Time Tag (Start Time and End Time) for GPS and IMU data. 
 
Note: There are several parameters that can be configured, and these parameters 
normally are not recommended to be modified from their default values. 
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Figure 16A: POSProc SBET 
 
 
! Quality of GPS Solution (Figure 17A) 
Adjusts signal quality scale selection, from lowest (C/A) to highest (ID). The 
adjustable sliding scale represents the auto-detected quality of available GPS data (ID 
= highest, C/A = lowest). ID = Integer Carrier Phase Differential GPS, FD = Float 
Carrier Phase Differential GPS, CD = Code Differential GPS, P = P-Code GPS, C/A 
= Code GPS. Every time SBET/IIN is run, the selected grade of accuracy becomes 
the default setting. 
 

 
Figure 17A: Quality of GPS solution 
 
Note: The higher the quality factor, the more weight was put in GPS solution in 
GPS/INS Kalman filter. 
 
! Output 

o Processing Time (sec), Entire Interval (checkbox): Delineates the total 
quantity of available data output (Figures 18A, 19A). 
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Figure 18A: Entire Time Interval 
 

 
Figure 19A: Customized Time Interval 
 
o Time Increment (sec): Regulates how frequent available data is output in 

the file. 
o Kalman Filter Time Increment (sec): Regulates how frequent the Kalman 

Filter data will be output in the file. 
 
 
! Navigator Initialization (Figure 20A) 

 

 
Figure 20A: Navigator Initialization 

 
o Initial Position 
o Initial Velocity 
o Initial Attitude 
o Alignment Control: 
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Starting alignment is the alignment mode in which IIN starts. Coarse 
Leveling to Fine Alignment are used to align the IIN inertial navigator 
when the inertial data comes from an IMU. 
 

1) Select Coarse Leveling if initial roll, pitch and heading are 
completely unknown. 

2) Select GC Coarse Heading Init 1 if roll and pitch are known to 
within 2 degrees accuracy but initial heading is unknown, and 
GPS is selected as a source of velocity aiding data. 

3) Select PC Coarse Heading Init 1 if roll and pitch are known to 
within 2 degrees accuracy but initial heading is unknown, and 
DVS or DMI is selected as a source of velocity aiding data. 

4) Select GC Coarse Heading Init 2 if initial heading is known to 
within 45 degrees accuracy, and GPS is selected as a source of 
velocity aiding data. 

5) Select PC Coarse Heading Init 2 if initial heading is known to 
within 45 degrees accuracy, and DVS or DMI is selected as a 
source of velocity aiding data. 

6) Select Fine Alignment if initial heading is known to within Fine 
Alignment Heading Error value (default is 10 degrees) accuracy. 
Fine alignment heading error is the heading error in degrees at 
which IIN transitions to Fine alignment mode. The default value 
of 10 degrees is sufficient. You can select a smaller value, which 
will postpone the transition to Fine Alignment mode. You should 
note that IIN outputs smoother data only in Fine Alignment. 

 
! Subsystems Setup (Figures 21A, 22A, 23A) 
Level arms for GPS, IMU and reference are inputted here. 
 

 
 Figure 21A: General for Subsystems Setup 
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 Figure 22A: IMU for Subsystems Setup 
 

 
 Figure 23A: Primary GPS for Subsystems Setup 

 
1.d.3. Potential problems 

 
! Kalman filter measurement rejections 

IIN will terminate, by default, after 50 continuous measurement rejections. This 
implies that  

1) the inertial and aiding sensor data are not consistent at the beginning of a 
processing run or throughout the run, or  

2) The Kalman filter error model is inconsistent with the inertial and aiding 
sensor data. Measurement rejections during the critical alignment phase 
can result in an abnormal alignment and a resulting inertial navigation 
solution whose errors grow rapidly to the point that the Kalman filter 
model of these errors is no longer valid. 

! Wrong Configuration: An incorrect configuration may include an incorrect IMU, 
GPS or POS type. 
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! Wrong Geometry: An incorrect user-to-IMU frame geometry entered in the 
Subsystems window can result in measurement rejections. If the IMU is mounted 
with the IMU frame rotated with respect to the user frame, then continuous 
measurement rejections will likely occur. 

! Time Alignment Error: A key requirement for a successful integration of inertial 
and aiding sensor data is good time alignment among the input data. Time 
alignment implies that the time stamps on the various input data are accurate and 
consistent with each other. 

! Data Gaps in IMU Data: An inertial navigator computes a navigation solution 
essentially by integrating the IMU data (it in fact solves Newton's equations of 6 
degree-of-freedom motion on the ellipsoidal rotating Earth). Continuity of IMU 
data is essential. An IMU data gap of more than one or two samples results in a 
sudden change in navigation accuracy that is inconsistent with the Kalman filter 
error model of inertial navigator errors. The inertial navigation solution becomes 
inconsistent with the aiding sensor data and measurement rejections can result. 
IMU data gaps are almost always caused by the IMU data acquisition system. If 
continuous measurement rejections appear to begin after a period of seemingly 
successful integration, then one or more IMU data gaps may be the cause. 
Viewing pre-processed (extracted) IMU data records and analyzing the results of 
the IMU continuity checking utility, at and around the time of measurement 
rejection may help identify and isolate error sources. Forcing data at specific 
error-ridden junctures may help resolve the problem. 

! Incorrect Subsystem Error Statistics: If overly optimistic RMS errors arrive from 
the GPS receiver or other aiding sensor, and adaptive measurements are selected, 
the filter finds inconsistencies between the actual measurement errors and the 
predicted accuracy, resulting in measurement rejections. Moving the GPS Type 
slide bar, in a decreasing GPS accuracy direction as well as increasing the 
adaptive scale factor, and/or measurement RMS values, will help resolve the 
problem. 

! Coarse Leveling Failure: Starting the Coarse Leveling alignment mode during 
acceleration maneuvers can cause coarse alignment failure where roll and pitch 
are computed incorrectly to the vehicle dynamics. For best results, start the post-
processing integrated inertial navigation process when the vehicle is stationary or 
moving at a constant velocity. 
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Level arm (Table 4B) 
User0/IMU lever arm 0.124 0.000 -0.047 m 
User0/IMU Alignment Angles(R, P, Y) 0.000000 -90.000000 0.000000 deg 
Primary GPS Anntenna lever arm -0.042 -0.003 -1.022 m Reference 

Primary GPS Anntenna lever arm s.d. 0.02 0.02 0.02 m 
Table 4B: Lever arm offsets 
 
1.e. Toledo dataset on Dec. 03 2002 

 
1) Data Description:  
 

Toledo Dec. 03, 2002  
 
The Applanix was "turned on" on the ground at OSU airport (approx. 10:05 AM). After about 
10 minutes initialization on the ground we took off to our photo job in the Defiance area.  
About 10:50 AM we flew a "figure 8" pattern somewhere over Northwest Putnam County 
before starting taking any photo. The weather went bad so we decided to turn off the Applanix 
in flight on our way to the Toledo Metcalf airport. In this block of data there is no photo 
events.  
 
At 1:50 PM the Applanix was again turned on (in flight start) on our way to the Toledo area in 
Lucas County for our next photo job.  
  
 At 15:30 the Applanix was turned off over Northern Lucas County in flight to OSU airport.  
 

2) Base Stations (Table 5B) 
 

Station Name PCL1 XYZ PCL1 BLH Comment 
467314.198 41 16 37.27488 N 

-4777688.986 84 24 48.84760 W Defi 
4185713.801 183.1981 

CORS 

574288.306 41 4 29.89682 N 
-4780915.736 83 9 1.41543 W Tiff 
4168842.402 211.7497 

CORS 

542671.7084 41 36 46.22400 N 
-4744847.3164  83 28 31.40175 W Tldo 
4213652.4089 153.6196 

Trimble 
Office 

494661.2160 40 18 37.26539 N 
-4845525.5550 84 10 15.90730 W Sidn 
4104513.7730 293.5440 

CORS 

592757.0630 39 57 35.11261 N 
-4859704.8780  83 2 44.74742 W Colb 
4074681.1330 186.5667 

CORS 

Table 5B: Base Stations for Dec. 3, 2002 Toledo dataset 
Note: PCL1: Phase Center for L1 
 

3) Trajectory (Figure 24B) 
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Figure 24B: Trajectory for Dec. 3, 2002 Toledo dataset 
 
Five base stations are available for this dataset with varying Base-Rover separations. 
So, in order to utilize the nearest base stations, a strategy for GPS data processing can 
be carried out as followed: 
Divide the original GPS dataset into two datasets and use different base stations for 
different segments. (Table 6B) 
 

 Start Time End Time Forward Base Backward Base 
Segment I 227165 230313 Colb Defi 
Segment II 240586 243020 Tldo Tldo 

Table 6B: Two segments from the original dataset. 
 

4) GPS Data processing for Segment I 
 
Processing using Base Station Colb 
Options used (Table 7B) 
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Category Sub Category Values 

Process Direction Both 
Process Data Type Dual frequency carrier phase Process 
Static Initialization Float ambiguity or kinematic initialization 
Dual frequency 
measurement usage 

Use L2 for Ambiguity resolution 
Use L2 for ionospheric processing Dual 

frequency Ionospheric processing Ionosperic free model 

Standard deviation 
C/A code: 3m 
L1 phase: 0.02m 
P2 code: 0.5m Standard 

deviation 
Rejection tolerance 

C/A code: 12m 
L1 phase: 0.1m 
P2 code: 2.5m 

Table 7B: Options used to process dataset segment I using base station Colb 
Note: Others options will be same as default. 
 

 
Figure 25B: Ambiguity fixed information for solution using Base Station Colb 
 
Although the ambiguity fixed information for solution using base station Colb (Figure 
25B) indicate good solution, however, the forward/backward separation (Figure 26B) 
show bad agreement in the begin and at the end between forward and backward 
solution. This should be the wrong solution is backward solution. The 
forward/backward separation of solution using base station Defi (Figure 27B) 
indicates a better agreement, even though this solution is based on float ambiguity.  
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Figure 26B: Forward/Backward Separation of solution using base station Colb 
 

Figure 27B:  Forward/Backward Separation of solution using base station Defi 
 
The final solution can be achieved by combining the forward solution using base 
station Colb and the backward solution using Defi (Figure 28B). 
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Figure 28B: Combined solution from forward solution using base station Colb and 
backward solution using base station Defi. 
 

 
Figure 29B: Position Standard deviation of the combined solution. 
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Figure 30B: Combined RMS of the combined solution. 
 

5) IIN Kalman Filter Data processing for Segment I 
 
Problems exist when running IIN Kalman Filter  
227846.004896 - Too many consecutive IIN measurement rejections 
 

Different parameter configurations were tested to process the data, but all failed. 
 

6) GPS Data processing for Segment II 
 
Processing using Base Station Tldo 
Options were applied same as Table 7B. 
 
The forward/Backward separation, the Combined RMS and position standard 
deviation indicate that the solution is a good solution. 
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Figure 31B: Forward/Backward Separation 
 

 
Figure 32B: Ambiguity Fixed information 
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Figure 33B: Combined RMS 
 

 
Figure 34B: Position Standard Deviation 
 

7) IIN Kalman Filter Data processing for Segment II 
 
Successfully obtained the solution using default parameters 
 
The zero-mean bound measurement residuals of N, E, D indicate correctness of IIN 
Kalman Filter (Figure 35B). 
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Figure 35B: Measurement Residual 
 

 
Figure 36B: Estimated Errors and RMS 
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Figure 37B: Smoothed Estimated Errors and RMS 
 

1.f. Franklin 670 dataset on Dec. 6 2002 
 

1) Data Description 
 
Franklin 670 dataset on Dec. 6, 2002  
Applanix turned on in flight 10:00 over Western Franklin County. Then we flew for 
approx. 3 minutes straight and level. At 10:05 we flew a "figure 8" pattern. At 10:09 
we started the climb up to the photo flight level.   
On the site (over downtown Columbus), we flew until 10:28.  
After flying straight for approx. 1 minute the Applanix was turned off in flight 
heading East from Franklin Co to Fairfield County.  
 

2) Base Stations (Table 8B) 
 

Station Name PCL1 XYZ PCL1 BLH Comment 
698831.4080 39 39 39.03114 N 

-4867123.7930 81 49 45.12251 W Mcon 
4049241.1370 272.7985 

CORS 

634180.8892 40 22 56.57512 N 
-4824018.3128 82 30 38.38094 W Mtvr 
4110605.4927 286.6493 

CORS 

494661.2160 40 18 37.26539 N 
-4845525.5550 84 10 15.90730 W Sidn 
4104513.7730 293.5440 

CORS 

592757.0630 39 57 35.11261 N 
-4859704.8780  83 2 44.74742 W Colb 
4074681.1330 186.5667 

CORS 

 
Note: PCL1: Phase Center for L1 

    
3) Trajectory 



High-Accuracy Direct Aerial Platform Orientation with Tightly Coupled GPS/INS System 
 

63 

 

 
 

Figure 38B: Trajectory for Dec. 6, 2002 Franklin 670 dataset 
 

4) GPS Solution 
 

Time Problem 
There was a jump in the RINEX file after the epoch 
  2 12  6 15 29 46.0000000  0  7G 1G 2G 3G 6G25G13G20                
The time jumped to  
  2 12  9 15 33 20.5000000  0  6G 1G 2G25G13G 3G20                    
We got “9” to “6” since this epoch. 
 

Figure 39B: Timeline for Base and Rover Stations after fixed the Time problem. 
 
 Note: The IMU data also have the same time problem. 
  
 Trajectory indicate that Colb should be the best base station 
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Figure 40B: Forward/Backward Separation 
 

 
Figure 41B: Ambiguity Fixed Information 
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Figure 42B: Combined RMS 
 

 
Figure 43B: Position Standard Deviation 
 

 
5) IIN Kalman Filter solution 

 
Successfully obtained the solution using default parameters 
 
The zero-mean bound measurement residuals of N, E, D indicate correctness of IIN 
Kalman Filter (Figure 44B). 
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Figure 44B: Measurement Residual 
 

 
Figure 45B: Estimated Errors and RMS 
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Figure 46B: Smoothed Estimated Errors and RMS 
 

1.g. Defiance mapping dataset on Dec. 9 2002 
 

1) Data Description 
 

Defiance mapping dataset on Dec. 9, 2002 
Applanix start on the ground at OSU airport at 10:34  
 
The photo job was in Defiance County from 11:32 to 11:49 
 
Applanix turned off on the ground at the ramp in OSU airport.  
 

2) Base Stations (Table 9B) 
 

Station Name PCL1 XYZ PCL1 BLH Comment 
467314.198 41 16 37.27488 N 

-4777688.986 84 24 48.84760 W Defi 
4185713.801 183.1981 

CORS 

574288.306 41 4 29.89682 N 
-4780915.736 83 9 1.41543 W Tiff 
4168842.402 211.7497 

CORS 

539114.21240 40 37 49.64124 N 
-4817544.83072 83 36 53.27947 W Kntn 
4131538.01516 265.9687 

Trimble 
Office 

494661.2160 40 18 37.26539 N 
-4845525.5550 84 10 15.90730 W Sidn 
4104513.7730 293.5440 

CORS 

592757.0630 39 57 35.11261 N 
-4859704.8780  83 2 44.74742 W Colb 
4074681.1330 186.5667 

CORS 

Table 9B: Base Stations for Dec. 9, 2002 Defiance mapping dataset 
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3) Trajectory  
 

 
Figure 47B: Trajectory for Dec. 9, 2002 Defiance mapping dataset 

 
4) GPS Solution 

 
Trajectory indicates that Defi and Kntn should be the best base station, However, 
results indicate that Kntn have worse performance than Defi. 

 
The following results are based on solution using base station Defi. 
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Figure 48B: Forward/Backward Separation 
 

 
Figure 49B: Combined RMS 
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Figure 50B: Position Standard Deviation 

 
5) IIN Kalman Filter solution 

 
Successfully obtained the solution using default parameters 
 
The zero-mean bound measurement residuals of N, E, D indicate correctness of IIN 
Kalman Filter (Figure 52B). 
 
 

 
Figure 51B: PosProc Estimated Errors and RMS 
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Figure 52B: PosProc Measurement Residuals and RMS 
 

 
Figure 53B: PosProc Smoothed Estimated Errors and RMS 
 

 
1.h. Defiance airport dataset on Dec. 10 2002   
 

1) Data Description 
 

Defiance airport dataset on Dec. 10, 2002 
Applanix turned on in flight at 10:43 near the site in Defiance County.  
 
Applanix turned off on the air at 12:56 

 
2) Base Stations (Table 10B) 

 
3) Trajectory (Figure 54B) 
 
4) GPS Solution 

 
The forward/backward separation of solution using Defi has a bad performance at the 
end of the data, so another base station Woos was applied to get another solution. The 
final solution is based on the forward solution using base station Defi and backward 
solution using base station Woos. 
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Station Name PCL1 XYZ PCL1 BLH Comment 

467314.198 41 16 37.27488 N 
-4777688.986 84 24 48.84760 W Defi 
4185713.801 183.1981 

CORS 

574288.306 41 4 29.89682 N 
-4780915.736 83 9 1.41543 W Tiff 
4168842.402 211.7497 

CORS 

539114.21240 40 37 49.64124 N 
-4817544.83072 83 36 53.27947 W Kntn 
4131538.01516 265.9687 

Trimble 
Office 

494661.2160 40 18 37.26539 N 
-4845525.5550 84 10 15.90730 W Sidn 
4104513.7730 293.5440 

CORS 

592757.0630 39 57 35.11261 N 
-4859704.8780  83 2 44.74742 W Colb 
4074681.1330 186.5667 

CORS 

 
 Woos 
 

CORS 

Table 10B: Base stations for Dec. 10, 2002 Defiance Airport Dataset 
 

 
Figure 54B: Trajectory for Dec. 10, 2002 Defiance Airport Dataset 
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Figure 55B: Combined RMS 
 

 
Figure 56B: Forward/Backward Separation 
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Figure 57B: Ambiguity Fixed Information 
 

5) IIN Kalman Filter solution 
 

Successfully obtained the solution using default parameters 
 
The zero-mean bound measurement residuals of N, E, D indicate correctness of IIN 
Kalman Filter (Figure 59B). 

 

 
Figure 58B: PosProc Estimated Errors and RMS 
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Figure 59B: PosProc Measurement Residuals and RMS 
 

 
Figure 60B: PosProc Smoothed Estimated Errors and RMS 
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2. Addendum 1 
2.b. Effects of GPS Data processing parameters 
 

Numerous options provided in the GPS data processing PosGPS mainly focus on the 
1) Usage of P code 
2) Quality of Code and phase measurement 
3) KAR engaged time and search region size 
4) Ionospheric modeling 

 
All these options, different from default setting are recommended to try and compare 
with the solution from default setting, only when problems exist in the solution from 
default setting.  
Here, as an example, “Use P Code in Kalman Filter” was used to test the effect. 
 

! Use P Code in Kalman Filter 
 

Applying this option, normally will increase the convergence speed, and sometimes 
will lower the combined RMS, position standard deviation and forward/backward 
separation, depending on the quality of P-code. Normally don’t apply this option. 
 
Before (Figures 61B, 62B, 63B, 64B): => do not apply this option 
 

 
Figure 61B: Position Standard Deviation 
 



High-Accuracy Direct Aerial Platform Orientation with Tightly Coupled GPS/INS System 
 

77 

 

 
Figure 62B: Combined RMS 
 

 
Figure 63B: Forward/Reverse Separation 
 



High-Accuracy Direct Aerial Platform Orientation with Tightly Coupled GPS/INS System 
 

78 

 

After (Figures 64B, 65B, 66B): Apply this option 
 

 
Figure 64B: Position Standard Deviation 
 

 
Figure 65B: Combined RMS 
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Figure 66B: Forward/Reverse Separation 
 
 




